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1 Einleitung 
 
Der Ozon-Tester Aeroqual ist ein hochgenaues Messgerät zur Messung der Ozonkonzentrationen in 
unserer Umluft. Der Ozon-Tester Aeroqual kann mit einem von vier, sich in dem Messbereich 
unterscheidenden, Sensorköpfen bestückt werden. Die Einsatzmöglichkeiten des Ozonmesser Aeroqual 
erstrecken sich innerhalb der Industrie auf Betriebe der Papier-, Textil-, oder Schmierstoffherstellung die 
in ihren Prozessen zum Bleichen von Ölen, Fetten, Wachs, Papier, synthetischen Fasern, Zellstoff oder 
Textilien Ozon verwenden. Einen weiteren Einsatzbereich findet der Ozontester Aeroqual nach und 
während Reinigungsarbeiten, Desinfektionsarbeiten und Entkeimungsarbeiten die z.B. in 
Schwimmbädern Wasseraufbereitungsanlagen oder nach Brandschäden und Wasserschäden mit Ozon 
durchgeführt werden. Mit dem Sensorkopf für den unteren Messbereich bis 0,150 ppm können Ozon 
Konzentrationen gemessen werden die auf die Befindlichkeit des Menschen negativ wirken. Durch die 
Verwendung führender GSS Technology Sensoren hat der Ozonmesser Aeroqual eine hohe 
Messgenauigkeit sowie eine sehr lange Lebensdauer der Sensorköpfe. Die einzigartige Möglichkeit die 
Sensoren aufzufrischen, bietet gegenüber anderen Sensor-Technologien, eine kostengünstige 
Unterhaltung der Geräte. Je nach Modell können die gemessenen Konzentrationen über eine analoge 
Schnittstelle mit einem 0…5 V Ausgangsignal ausgegeben, in dem internen Speicher geschrieben oder 
über eine RS232 Schnittstelle zu einem PC übertragen werden. Durch die Einfachheit der Bedienung 
können in kürzester Zeit die Alarmschwellen für die optische oder akustische Signalisierung verändert 
werden. Auf dem LCD Display werden neben den gemessenen Konzentrationen, die in ppm oder mg/l 
angezeigt werden, auch die hoch und tief Alarme dargestellt. 
 
 

2 Lieferumfang 
 

Serie 200 und 300 Serie 500 

1 x Basisgerät   
1 x Sensorkopf 
1 x 12,6 V Stecker Netzgerät 
1 x Bedienungsanleitung 
1 x Lithium-Polymer Akku 12 V DC / 2700 mAh  
 
Optional:  
- Temperatur und Feuchtesensor 

1 x Basisgerät   
1 x Sensorkopf 
1 x USB Kabel 
1 x 12,6 V Stecker Netzgerät 
1 x Bedienungsanleitung 
1 x Lithium-Polymer Akku 12 V DC / 2700 mAh  

Optional:  

- Temperatur und Feuchtesensor 

- 2 Wege Adapterkabel 
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3 Spezifikationen 
 

Messeinheiten ppm oder mg/m³ 

Messfunktionen Minimum, Maximum, Durchschnitt 

Sensorkopf Austauschbar 

Display LCD 

Display Symbole Batteriestand, Sensortyp, Standby, Mute, Alarm, 
Geräte ID, Standort ID 

Kalibrierungsoptionen (Serie 300 / 500) Nullpunkt, Messbereich per. Geheimmenü 

Spannungsversorgung Akku 12 V DC / 2700 mAh oder Netzgerät 12,6 V 

Temperatur und Feuchtesensor Temp: -40°C … 124°C;  RH: 0 … 100% 

Abmessungen 195 x 122 x 54 mm 

Gehäusematerial / Schutzklasse Pc, ABS / IP 20 

Gewicht (inkl. Sensorkopf und Batterien) Ca. 460 g 

Betriebstemperatur / Feuchtigkeit -5 °C ... 45 °C / 0 … 95% 

Akustischer Alarm (Serie 300 / 500) Niedrig / Hoch 

Steuerungsausgang (Serie 300 / 500) 
Unbedingt Diode verwenden! (siehe Kap. 8.1.2) 

12 VDC oder Schalter zu Masse (max. 150 mA) 

Analogausgang (Serie 300 / 500) 0 – 5 V 

Digitalausgang (Serie 500) RS232 / USB Adapter 

Speicherkapazität (Serie 500) 8188 Messwerte 

 
 
 
 

  

http://www.warensortiment.de/


 BETRIEBSANLEITUNG  
www.warensortiment.de 

 

6 

4 Sicherheit 
 
Bitte lesen Sie vor Inbetriebnahme des Gerätes die Bedienungsanleitung sorgsam durch. Schäden, die 
durch Nichtbeachtung der Hinweise in der Bedienungsanleitung entstehen, entbehren jeder Haftung. 
 

4.1 Warnsymbole 

 

Allgemeine Warnung.  
Ziehen Sie unbedingt die Dokumentation zu Rate.  

 

Betriebsspannung unter Sollwert.  
Batterien auswechseln, sonst Fehlmessungen möglich 

 

4.2 Warnhinweise 

 

 Dieses Messgerät darf nur in der in dieser Bedienungsanleitung beschriebenen Art und Weise 
verwendet werden. Wird das Messgerät anderweitig eingesetzt, kann es zu einer Gefahr für den 
Bediener sowie zu einer Zerstörung des Messgerätes kommen. 

 Gerät keinen extremen Temperaturen, direkter Sonneneinstrahlung, extremer Luftfeuchtigkeit 
oder Nässe aussetzen. 

 Das Öffnen des Gerätegehäuses darf nur von Fachpersonal der PCE Deutschland GmbH 
vorgenommen werden. 

 Das Messgerät darf nie mit der Bedienoberfläche aufgelegt werden (z.B. tastaturseitig auf einen 
Tisch). 

 Benutzen Sie das Messgerät nie mit nassen Händen. 

 Es dürfen keine technischen Veränderungen am Gerät vorgenommen werden. 

 Das Gerät sollte nur mit einem feuchten Tuch gereinigt werden. Keine Scheuermittel oder 
lösemittelhaltige Reinigungsmittel verwenden. 

 Das Gerät darf nur mit dem von PCE Deutschland angebotenen Zubehör oder gleichwertigem 
Ersatz verwendet werden. 

 Vor jedem Einsatz dieses Messgerätes, bitte das Gehäuse auf sichtbare Beschädigungen 
überprüfen. Sollte eine sichtbare Beschädigung auftreten, darf das Gerät nicht eingesetzt 
werden. 

 Weiterhin darf dieses Messgerät nicht eingesetzt werden wenn die Umgebungsbedingungen 
(Temperatur, Luftfeuchte …) nicht innerhalb der in der Spezifikation angegebenen Grenzwerten 
liegen. 

 Setzen Sie den Sensorkopf (nur Ozon) keiner übermäßig hohen Ozonkonzentration aus. Das 
Gerät ist für übliches Umgebungsklima, nicht für direkte Ozonströmungen ausgelegt. 

 Das Messgerät darf nicht in einer explosionsfähigen Atmosphäre eingesetzt werden. 

 Wenn die Batterie leer ist, (wird z. B. durch den Batterieindikator angezeigt) darf das Messgerät 
nicht mehr verwendet werden, da durch falsche Messwerte Lebensgefährliche Situationen 
entstehen können. Nachdem wieder volle Batterien eingesetzt wurden, darf der Messbetrieb 
fortgesetzt werden. 

 Vor jedem Einsatz bitte das Messgerät durch das Messen einer bekannten Größe überprüfen. 

 Die in der Spezifikation angegebenen Grenzwerte für die Messgrößen dürfen unter keinen 
Umständen überschritten werden. 

 Wenn das Messgerät über eine längere Zeit nicht eingesetzt werden soll, entfernen Sie bitte die 
Batterien, um eine Beschädigung durch ein Auslaufen der Batterie zu vermeiden. 

 Bei Nichtbeachtung der Sicherheitshinweise, kann es zur Beschädigung des Gerätes und zu 
Verletzungen des Bedieners kommen. 

 
Bei Fragen kontaktieren Sie bitte die PCE Deutschland GmbH. 
 
 

  

http://www.warensortiment.de/


 BETRIEBSANLEITUNG  
www.warensortiment.de 

  

 

5 Gerätebeschreibung 
 

AQ200 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 
(1) Sensorkopf 

(2) Power-Taste (Standby-Taste) 

(3) Display 

(4) Enter-Taste (Eingabetaste) 

(5) Batteriefach 

AQ300 / 500 
 

   
 
 
 
 
 
 
 
 
 

 
 
 

 
(1) Sensorkopf 

(2) Power-Taste (Standby-Taste) 

(3) Display 

(4) Alarmtonstummschaltung (Mute) 

(5) Enter-Taste (Eingabetaste) 

(6) Scrollen (Hoch) 

(7) Scrollen (Runter) 

(8) Batteriefach 

 
 
 
 
 
 
 
 

 

 
(1) Power-Taste 

(2) Alarmtonstummschaltung (Mute) 

(3) Enter-Taste 

(4) Scrollen (Hoch) 

(5) Scrollen (Runter) 
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6 Betriebsanleitung 
 
Die folgenden Aktionen müssen ausgeführt werden bevor das Gerät in Betrieb genommen werden kann. 

 Schließen Sie den Sensorkopf an das Gerät an. Der Sensorkopf ist makiert um eine Korrekte 
Installation zu gewährleisten. 

 Die Batterie muss mit dem Gerät verbunden und aufgeladen werden (Die Batterie ist bereits in 
dem Gerät eingebaut jedoch nicht angeschlossen). 

 Optional: Schließen Sie den Temperatur und der RH Sensor an. 
 

6.1 Einsetzen des Akkupacks 

 

 
1. Klappen Sie die Batteriefachabdeckung (5) vom Gerät weg. 
2. Verbinden Sie den elektrischen Anschluss des Akkupacks mit dem des Messgeräts. 
3. Legen Sie das restliche Verbindungskabel in die vorgesehene Aussparung und führen Sie den 

hinteren Teil des Akkupacks in die Gelenkpunkte des Batteriefachs ein. 
4. Führen Sie den vorderen Teil des Akkupacks in die Halteclips ein (beachten Sie eventuelle 

Ausrichtungshinweise auf dem Akkupack). 
5. Setzen Sie die Batteriefachabdeckung wieder auf. 

 

6.2 Laden des Akkupacks 

 
Da das Gerät über ein intelligentes Management zur Ladung verfügt, erfolgt der Ladeprozess nur wenn 
das Gerät eingeschaltet ist oder sich im Standby-Modus befindet. Während der Ladung blinkt das 
Batteriesymbol im Display in niedriger Frequenz. Das Akkupack kann mit oder ohne montierten 
Sensorkopf im Gerät geladen werden (achten Sie drauf vor Demontage des Sensorkopfes das Gerät 
auszuschalten). Nach einer Höchstladezeit von 15 Stunden beendet das Gerät den Ladevorgang. Ziehen 
des Netzsteckers bewirkt einen Neubeginn der Ladezeit. Neue Ni-MH-Batterien müssen vor der ersten 
Nutzung vollständig geladen werden. Eine Ni-MH-Batterie entfaltet die volle Leistungsfähigkeit erst nach 
mehreren Zyklen von Ladung/Entladung. Ein vollgeladenes Akkupack hält für eine Dauer von ca. sieben 
Stunden (Perchloräthylen-Sensoren haben einen höheren Stromverbrauch und somit eine verkürzte 
Akkulaufzeit). Der Ladeprozess dauert im Standbymodus ca. 10, im Betriebsmodus ca. 15 Stunden. 
 

6.3 Warmlaufphase 

 
Vor der Nutzung benötigt das Gerät eine Aufwärmphase, um Verunreinigungen des Sensors zu 
verbrennen. Nach dem Einschalten wärmt das Gerät für drei Minuten auf. Danach blinkt die Anzeige für 
weitere sieben Minuten, um zu zeigen dass das Gerät noch immer in der Aufwärmphase ist. Es empfiehlt 
sich das Gerät bei Nichtnutzung im Standby-Modus zu belassen, um den Sensor warm zu halten und so 
Verunreinigung des selbigen zu verhindern. Wenn das Gerät mehr als sieben Tage ausgeschaltet war, 
sollte es vor einer Benutzung für 24 Stunden (über den Netzadapter) betrieben werden. 
 

Warnung: Nehmen Sie den Sensorkopf nicht ab während das Gerät eingeschaltet ist! Dies 
kann das Gerät beschädigen. Sollte dennoch eine Demontage des Sensors bei 
eingeschaltetem Gerät erfolgen, schaltet dieses sich automatisch ab.  
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6.4 Ausfall des Sensorkopfs 

 
Es gibt Drei Anzeigen welche auf ein Problem mit dem Sensorkopf hinweisen: 
 
„Sensor Failure, Replace sensor“: Der Sensorkopf sollte getauscht werden, da ein Komponentenfehler 
vorliegt oder der Sensor das Ende seiner Lebensdauer erreicht hat. 
 
„Sensor aging“: Der Sensorkopf sollte schnellstmöglich getauscht werden, da er das Ende seiner 
Lebensdauer erreicht hat. Die Messergebnisse sind nicht länger verlässlich.  
 
Anmerkung: Diese Meldungen betreffen nur O3 Low/Ultra Low Sensorköpfe. 
 
„S.F.“: Diese Fehlermeldung erscheint wenn mehr als ein Sensor angeschlossen ist. 
 

6.5 Optionaler Temperatur und Feuchtesensor 

 
Der Optionale Temperatur und Feuchtesensor wird an der Unterseite des Gerätes angeschlossen. 
Achten Sie darauf dass das Gerät ausgeschaltet ist wenn Sie den Sensor anschließen. 
 

6.6 Ein- und Ausschalten des Geräts 

 
Um das Gerät einzuschalten, drücken und halten Sie die Power-Taste bis ein Ton erklingt und das 
Display aktiviert wird. Im Display wird die Version des Geräts und der Software angezeigt. Nach fünf 
Sekunden wird der Sensortyp angezeigt und die Aufwärmphase (wie oben beschrieben) beginnt. Nach 
Abschluss der Aufwärmphase erfolgt die Hauptanzeige, wie hier exemplarisch erkennbar: 
 

 
 
Um das Gerät auszuschalten, drücken und halten Sie die Power-Taste  für ca. zwei Sekunden. Ein Ton 
erklingt und die Displayanzeige verschwindet. 
 

6.7 Ein- und Ausschalten des Standby-Modus 

 
Um bei eingeschaltem Gerät in den Standby-Modus zu gelangen, drücken Sie (einmalig und kurz) die 
Power-Taste. Dies beendet die Messfunktion; der Sensor wird jedoch warmgehalten. Dieser Modus 
ermöglicht es Energie zu sparen, und dennoch nur eine kurze Aufwärmphase bei Wiederaufnahme der 
Messtätigkeit hinnehmen zu müssen. In diesem Modus Zeigt das Display ein Standby Symbol und den 
Sensortyp an. Um in den Messmodus zurückzukehren, drücken Sie erneut (einmalig und kurz) die 
Power-Taste. 
 
Hinweis: Bei Verwendung eines Kohlendioxid-Sensors wird dieser im Standby-Modus mit voller Leistung 
betrieben. Auch der Lüfter bleibt eingeschaltet. 
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6.8 Nutzung der Menüs und Funktionstasten 

 
Um in das Menü zu gelangen, drücken Sie die Eingabetaste. Eine der folgenden Anzeigen erscheint 
(Abhängig von dem verwendeten Gerät). 
 

Serie 200 Serie 300 Serie 500 

 
EXIT 
ZERO CAL 
UNITS 
MIN MAX AV 
     MUTE KEY 
 

 
EXIT 
LOCATION ID 
MAX MIN AV 
CALIBRATE 
MONITOR SET UP 

 
EXIT 
LOCATION ID 
MAX MIN AV 
CALIBRATE 
MONITOR SETUP 
LOGGING SETUP 

 
 

 
 

 
 

  
EXIT 
MONITOR ID 
UNITS 
OUTPUT SENSOR 
ALARM POINTS 
CONTROL POINTS 
MUTE KEY 
 

EXIT 
MONITOR ID 
UNITS 
OUTPUT SENSOR 
ALARM POINTS 
CONTROL POINTS 
MUTE KEY 
CLOCK SETUP 

 
Benutzen Sie die Scroll-Tasten um zum gewünschten Menüpunkt zu scrollen. Mit der Enter-Taste 
bestätigen Sie Ihre Auswahl.  
 

6.8.1 Tastentöne stummschalten 

 
- Um die Tastentöne auszuschalten wählen Sie den Menüpunkt „MUTE KEY“ aus (bei der Serie 

300 und 500 ist dieser unter „MONITOR SETUP“ zu finden).   
- Nach Betätigung der Enter-Taste erscheint das Word muted auf dem Display. 
- Bei der Serie 200 werden die „Mute Einstellungen“ beim Ausschalten des Gerätes zurückgesetzt. 

 

6.8.2 Nullkalibrierung  

 
- Um zur Nullkalibrierung zu gelangen, wählen Sie im Menü den Punkt „ZERO CAL“ (Serie 200) 

oder „CALIBRATE“ (Serie 300 und 500) aus.  
- Um in das Kalibrierungsmenü zu gelangen müssen die „mute“ und die „Scroll-Taste“ (Runter) für 

2 Sekunden gedrückt werden. 
- Die Nullkalibrierung legt den Nullpunkt für die Messung fest. Die Kalibrierung muss unter 

strengen Bedingungen erfolgen.  
 
Hinweis: Eine fehlerhafte Nullkalibrierung führt nicht zu einem dauerhaften Schaden am Gerät. Die 
Kalibrierung sollte allerdings unter den vorgegeneben Bedingungen wiederholt werden. 
 

Warnung: Die Nullkalibrierung von Kohlendioxidsonden muss zwingend in einer qualifizierten, 
umgebungsluftfreien Atmosphäre erfolgen. Im Zweifelsfall kontaktieren Sie uns bitte. 
 

 
Eine genaue Anleitung zur Nullkalibrierung finden Sie unter Punkt 8. 
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6.8.3 Ändern der Messeinheiten 

 
- Zur Messeinheiten-Auswahl gelangen Sie über den Menüpunkt „UNITS“ (bei der Serie 300 und 

500 ist dieser unter „MONITOR SETUP“ zu finden). 
- Nutzen Sie die Pfeiltasten um zwischen ppm und mg/m³ zu wählen. Bestätigen Sie die 

Einstellungen mit der Eingabetaste. 
- Wenn ein Temperatur und Feuchtigkeitssensor angeschlossen ist, können Sie zwischen  

°C und °F wählen.  
 

6.8.4 Einstellen der Uhr (nur Serie 500) 

 
- Um die Uhrzeit einzustellen wähle Sie im Menü den Punkt „CLOCK SETUP“ aus (zu finden unter 

„MONITOR SETUP“). 
- Um die Stunden zu ändern benutzen Sie die Scroll-Tasten. Bestätigen Sie Ihre Einstellungen mit 

der Eingabetaste. Bedenken Sie bitte dass es sich um eine 24-Stunden-Uhr handelt. Nach der 
Bestätigung rückt der Cursor automatisch zur nächsten Stelle vor. Die Einstellung der anderen 
Zeitparameter funktioniert nach demselben Schema.  

- Um zum nächsten Menüpunkt zu gelangen, betätigen Sie die Scroll-Taste (Runter).  
 

14:30:12 

Oct 07 12 

Stunden : Minuten : Sekunden 

Monat : Tag : Jahr 

 

6.8.5 Standort ID (nur Serie 300 und 500) 

 
- Die Standort ID zeigt an wo die Messung vorgenommen wurde, Sie wird automatisch bei jeder 

Messung gespeichert.  
- Um die Standort ID aufzurufen wählen Sie das Menü „LOCATION ID“ aus. 
- Drücken Sie die Enter-Taste um die Standort ID zu bestätigen und in das Einstellungsmenü 

zurückzukehren.  
 

6.8.6 Einstellen der Geräte ID (nur Serie 300 und 500) 

 
- Die Geräte ID finden Sie unter dem Menüpunkt „MONITOR ID“ (zu finden unter „MONITOR 

SETUP“). 
- Bestätigen Sie Ihre Einstellungen mit der Eingabetaste. 
- Jedes Gerät kann mit einer eigenen ID versehen werden, dies ermöglicht eine schnelle 

Identifikation wenn mehrere Geräte im Einsatz sind. 
- Sobald man die Daten auf den Computer überträgt, werden diese mit der Geräte ID versehen. 

Jeder Datensatz beinhaltet folgende Parameter: Datum / Zeit, Geräte ID, Standort ID, Sensor 
Typ, Messergebnis. 

 

6.8.7 Sensor-Auswahl (nur Serie 300 und 500) 

 
- Die Sensor-Auswahl finden Sie unter dem Menüpunkt „OUTPUT SENSOR“ (zu finden unter 

„MONITOR SETUP“). 
- Unter diesem Menüpunkt können Sie den Sensor auswählen für den die Alarmpunkte, 

Kontrollpunkte und die buzzers gelten (nur in Verbindung mit einem Mehrfachsensor 
erforderlich). 

- Die Auswahl gilt auch für das 0-5v Analogsignal. 
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6.8.8 Alarmeinstellungen (nur Serie 300 und 500) 

 
Einstellen der Alarmpunkte 

- Die Alarmpunkteinstellung finden Sie unter dem Menüpunkt „ALARM POINTS“ (zu finden unter 
„MONITOR SETUP“). 

- Nach dem Aufrufen des Alarm-Setup-Menüs wird „Alarm HI“ angezeigt. 
- Benutzen Sie die Pfeiltasten um den Wert zu ändern. Bestätigen Sie die Einstellung mit der 

Eingabetaste. 
- Nach Bestätigung der Einstellung des High-Alarms wechselt die Ansicht automatisch in die 

Einstellung des Low-Alarms. Im Display wird „Alarm LO“ angezeigt. 
- Benutzen Sie die Pfeiltasten um den Wert zu ändern. Bestätigen Sie die Einstellung mit der 

Eingabetaste. 
 
Ein- und Ausschalten des Alarms 

- Nach Bestätigung der Einstellung des Low-Alarms wechselt die Ansicht automatisch in die 
„Buzzer“ Einstellung.  

- Benutzen Sie die Pfeiltasten um zwischen „ENABLE“ (Aktiviert) und „DISABLE“ (Deaktiviert) zu 
wählen. Bestätigen Sie die Einstellung mit der Eingabetaste. 
 

Hinweis: Wenn der Alarm deaktiviert wurde, gilt diese Stummschaltung permanent. Ein „P“ im Display 
(rechts neben dem Stummschaltungssymbol) symbolisiert dies. 

 
Displayanzeige 

- Zwei nach oben weisende, blinkende Pfeile erscheinen im Display wenn der Messwert den 
oberen Alarmwert übersteigt. Akustisch wird der Alarm durch ein schnelles Piepen begleitet. 

- Zwei nach unten weisende, blinkende Pfeile erscheinen im Display wenn der Messwert den 
unteren Alarmwert unterschreitet. Akustisch wird der Alarm durch ein schnelles Piepen begleitet. 

 
Hinweis: Durch Betätigung der Mute-Taste können Sie den Alarm stumm schalten. Die Stummschaltung 
eines aktiven High- oder Low-Alarms gilt nur so lange die aktuelle Alarmbedingung vorliegt. 
 

6.8.9 Max / Min / Durchschnitt des Messungsdurchlaufs 

 
- Wählen Sie den Menüpunkt „MAX MIN AV“ aus. 
- Durch Betätigung der Enter-Taste starten / stoppen Sie die Max / Min / Durchschnitt-Prozedur.  
- Drücken Sie die Scroll-Taste (Runter) um zum Punkt „EXIT“ zu scrollen.  
- Drücken Sie die Enter-Taste um die Menüeinstellungen zu verlassen. Hierdurch wird auch,  

je nach Menüauswahl, der Durchlauf gestartet.  
 
Hinweis: Bei der Serie 300 und 500 kann die Funktion direkt vom Startbildschirm aus, ein und 
ausgeschaltet werden. Dazu halten Sie bitte die Pfeiltaste (Runter) für 2 Sekunden gedrückt, bis der 
akustische Signalgeber ertönt.  
 

- Um die Messung zu stoppen, drücken die erneut die Pfeiltaste (Runter) für mindestens zwei 
Sekunden, bis der akustische Signalgeber ertönt. 

 
Hinweis: Die MIN, MAX und AVE-Werte sind Minimal-, Maximal- und Durchschnittswerte seit Beginn des 
Messungsdurchlaufs. Der Wert „RD“ ist der momentane Messwert. 
 

- Wenn der Messvorgang gestartet wurde, erscheint folgende Anzeige: 
 

03 UL 
 
 
RD        
MIN       
MAX      
AVE      

 
 
PPM 
0.010 
0.005 
0.024 
0.015 

oder 

 
 
 
RD 
MIN 
MAX 
AVE 

03 UL 
 
PPM 
0.010 
0.005 
0.024 
0.015 

TEMP 
 

C 
23 
22 
25 
24 

RH 
 
% 
50 
50 
56 
54 
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6.8.10 Einstellen der Kontrollpunkte (nur Serie 300 und 500) 

 
- Die Kontrollpunkteinstellung  finden Sie unter dem Menüpunkt „CONTROL POINTS“ (zu finden 

unter „MONITOR SETUP“). 
- Nach dem Aufrufen des Kontrollpunkt-Menüs erscheint „CONTROL HI“ im Display. 
- Benutzen Sie die Pfeiltasten um den Wert zu ändern. Bestätigen Sie die Einstellung mit der 

Eingabetaste. 
- Nach Bestätigung der Einstellung des oberen Kontrollpunktes wechselt die Ansicht automatisch 

in die Einstellung des unteren Kontrollpunktes. Im Display wird „CONTROL  LO“ angezeigt. 
- Benutzen Sie die Pfeiltasten um den Wert zu ändern. Bestätigen Sie die Einstellung mit der 

Eingabetaste. 
 

6.8.11 Einstellen der Zeitintervalle des Datenloggers (nur Serie 500)  

 
- Um in das Logging-Menü zu gelangen, wählen Sie den Menüpunkt „LOGGING SETUP“ aus. 
- Im Display erscheint die Anzeige „LOG FREQ“.  

 

 
 

- Benutzen Sie die Pfeiltasten um den Loggingwert in 1-Minuten-Schritten zu ändern. Bestätigen 
Sie die Einstellung mit der Eingabetaste und die folgende Anzeige erscheint:  

 

 
 

- Sie können nun wählen ob Sie die geloggten Daten löschen oder behalten möchten, indem Sie, 
mittels der Pfeiltasten, zwischen „YES“ und „NO“ wählen. Hierbei bedeutet „YES“ dass die Daten 
gelöscht werden sollen. Bestätigen Sie die Einstellung mit der Eingabetaste und die folgende 
Anzeige erscheint:  
 

  
 

- Benutzen Sie die Pfeiltasten um zwischen  „ON“ und „OFF“ zu wählen. Bestätigen Sie die 
Einstellung mit der Eingabetaste und das Hauptmenü erscheint. 

- Sobald die Aufnahmefunktion gestartet wurde, erscheint ein Dreieck im Display. 
- Das Dreieck füllt sich langsam auf (10% Schritte), wenn es 100% erreicht hat ist der Speicher voll 

und die Daten müssen auf den Computer übertragen werden. 
 

Hinweis: Die Aufnahmefunktion kann direkt vom Startbildschirm aus, ein und ausgeschaltet werden. 
Dazu halten Sie bitte die Pfeiltaste (Hoch) für 2 Sekunden gedrückt, bis der akustische Signalgeber 
ertönt. 
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7 Anleitung für die Software 
 

7.1 Softwareinstallation 

 
Systemanforderungen (Minimum) 

 Betriebssystem: Microsoft Windows
TM

 2000 oder neuer 

 Prozessor: 1000 MHz 

 Arbeitsspeicher (RAM): 512 MB 

 Verfügbarer Festplattenspeicher: 100 MB 

 Schnittstelle: Seriell (oder mittels USB-Seriell-Adapter) 
 

Hinweis: Die Version S500 V6.0 ist abwärtskompatibel bis zur Version S500 V5.x, ältere Versionen sind 
inkompatibel. 
 

7.1.1 Anschließen 

 

 Verbinden Sie das Messgerät mittels des beiliegenden Kabels mit dem Computer und starten Sie 

das Programm S 500. 

 Klicken Sie in der Symbolleiste auf das  Symbol um das angeschlossene Gerät aufzurufen. 

 Testen Sie nun die Verbindung durch einen Klick auf das  Symbol. Die Software zeigt ihnen 

anschließend den Gerätename, die Geräteversion und die ID Nummer an.  

 

7.1.2 Konfiguration 

 
Dieses Kapitel der Anleitung befasst sich mit dem Vorgehen um mittels der Software die Geräte ID, 
Standort ID, Alarm und Kontrollwerte, Aufnahmeintervall, Maßeinheiten, den Ausgabesensor und die 
Uhrzeit einzustellen. 
 

 

 Drücken Sie auf „Monitor“ und anschließend auf „Setup“ 
(alternativ Strg + P). Nun erscheint das „Monitor Setup“ 
Dialogfenster. 
 

 Tragen Sie die benötigten Werte ein oder scrollen Sie 
weiter hoch bzw. runter um die Sollwerte einzustellen. 

 

 Drücken Sie die „Save“ Taste um die eingestellten 
Werte auf das Gerät zu übertragen. 
 

 Um sinnvolles Datenlogging zu betreiben ist es 
notwendig die Uhrzeit des Geräts korrekt einzustellen. 
Dies kann direkt über die Gerätetastatur oder über den 
Button „Update Clock“ der Software erfolgen.  

 
Hinweis: Wenn der Temperatur und Feuchtesensor 
angeschlossen ist erscheint zusätzlich die Option zum 
Einstellen der Temperatureinheit. 
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7.2 Datenlogging 

 
Die Geräte der Serie 500 können bis zu 8188 Werte aufzeichnen. Sollten mehrere Sensoren im Einsatz 
sein  wird der Gesamtwert durch die Anzahl der Sensoren geteilt. 
Beispiel: Bei der Verwendung eines Dreifachsensors ergibt dies eine Gesamtzahl von 8188/3 
Datensätzen. 
 

7.2.1 Direktes Datenlogging auf einem PC 

 
Stellen Sie sicher dass das Gerät mit dem PC verbunden ist. Klicken Sie auf „File -> Start PC Data 

Logging“ oder auf das Symbol . Die Daten werden nun direkt in der Datenbank auf dem PC 
gespeichert. In diesem Modus werden keine Daten im geräteinternen Speicher abgelegt. Wenn der 

Vorgang des direkten Datenloggings jedoch beendet wird (durch Klick auf den Button „Stop“ ), werden 
die ab diesem Moment folgenden Messdaten wieder im geräteinternen Speicher aufgezeichnet. 
 

7.2.2 Datenübertragung auf den PC 

 
Um geloggte Daten vom Gerätespeicher auf den PC zu überspielen, klicken Sie „File -> Download 
Logged Data“ oder drücken Sie das Shortcut-Symbol . 
Während die Daten heruntergeladen werden, wird ein Fortschrittsbalken angezeigt. Nach Abschluss des 
Download-Vorgangs piept das Messgerät. Die Software fragt ob die Daten im Speicher des Messegeräts 
nun gelöscht werden sollen. Daten müssen manuell gelöscht werden, ansonsten werden sich diese beim 
nächsten Download in der Datenbank des Computers duplizieren. 
Wenn der Datendownload nicht abgeschlossen, abgebrochen oder unterbrochen wird: 

 Schalten Sie das Messgerät aus um Datenverlust zu vermeiden 

 Löschen Sie die Daten welche bereits auf den PC übertragen wurden 

 Schließen Sie die Software 

 Wiederholen Sie den Download-Vorgang (vergessen Sie nicht dass das Gerät eingeschaltet sein 
muss) 

 

7.2.3 Grafische Darstellung 

 
Direktes Datenlogging: 

 Rufen Sie den Graph über das „Data“ Menü 
auf. 

 
Grafische Darstellung der geloggten Daten: 

 Stellen Sie sicher dass alle Daten vom 
Messgerät auf den PC übertragen wurden. 

 Klicken Sie „Data -> Graph -> Logged Data“. 

 Wählen Sie den Zeitraum dessen Daten im 
Graphen dargestellt werden sollen. 

 Wählen Sie die gewünschte Zeiteinteilung 
und den Sensor.        
 

Einstellungen: 

 Das Design des Graphen stellen Sie wie folgt 
ein:  

 Rechtsklick auf den Graph -> „Graph Style“. 

 Zum zurücksetzen der Einstellungen wählen 
Sie „ Reset to Default“. 

 Durch einen Rechtsklick auf den Graph 
können Sie diesen speichern bzw. 
ausdrucken.  
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7.2.4 Tabellarische Darstellung 

 
Direktes Datenlogging: 

 Rufen Sie die Tabelle über das „Data“ Menü auf. 
 
Tabellarische Darstellung der geloggten Daten: 

 klicken Sie „Data -> Table -> Logged Data“, die Tabelle wird angezeigt . 

 Wählen Sie den gewünschten Zeitraum und den Sensor. 

 Klicken Sie den Button „Apply“ um die Auswahl zu bestätigen und die Daten zu laden. 
 Alternativ: Wählen Sie „view all“ um den Filter auszuschalten, nun werden alle Parameter 

angezeigt. 

 Die Tabelle kann durch Klicken auf die jeweilige Kolumne sortiert werden (z.B. um nach 
Konzentration zu sortieren). 
 

Hinweis: Mittels des Buttons „Export“ kann die Zusammenfassung als Datei (z.B. für MS EXCEL
TM

) 
exportiert werden. Auch kann der Button „Delete“ zur Löschung der einzelnen Daten genutzt werden. 
 

 
 

7.2.5 Daten Analyse 

 
Die Tageszusammenfassung ist ein Bericht für jeden Tag, von Mitternacht bis Mitternacht, welcher die 
minimale, maximale und durchschnittliche Gaskonzentration der letzten 24 Stunden angibt. 
 

 Zur Erstellung und Betrachtung klicken Sie „Data -> Daily Analysis“.  

 Wählen Sie den Datenbereich, die Geräte ID und die Standort ID aus.  

 Klicken Sie den Button „Apply“ um die Analyse zu erstellen. 

 Alternativ: Wählen Sie „View All“ um den Filter auszuschalten, nun werden alle Parameter 
angezeigt.  

 
Hinweis: Der Erstellungsprozess kann zehn Minuten oder länger benötigen und darf nicht unterbrochen 
werden. Die Prozessdauer ist von der Menge der zu verarbeitenden Daten abhängig. 
 
Mittels des Buttons „Export“ kann die Zusammenfassung als Datei (z.B. für MS EXCEL

TM
) exportiert 

werden. Auch kann der Button „Delete“ zur Löschung der Zusammenfassung genutzt werden. Hierbei 
wird nur die Zusammenfassung gelöscht, nicht die zugrundeliegenden Daten. 
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7.3 Fortgeschrittenes Datenmanagement 

 
Gepackte Datei (Zip-database) erzeugen: 
Um aus der Datenbank eine gepackte Datei zu erzeugen, klicken Sie „File -> Zip Database“. Wählen Sie 
ein Zielverzeichnis und geben Sie einen Namen ein um eine Datei aus den gespeicherten Daten zu 
erstellen.  
 
Öffnen einer gepackten Datei: 
Um eine gepackte Datei zu öffnen, klicken Sie auf „File -> Unzip Database“. Wählen Sie die gewünschte 
Datei aus und klicken Sie auf „OK“. Die Daten können nun, wie in den vorherigen Punkten beschrieben, 
analysiert werden. 
  

Warnung: Soll eine gesicherte Datenbank angesehen werden, ist es von großer Wichtigkeit 
dass eine aktive Loggingfunktion nicht unterbrochen wird. Empfohlen wird, eine gesicherte 
Datenbank nicht auf dem PC anzusehen auf welchem ein Loggingvorgang durchgeführt wird, 

da, wenn Daten wiederhergestellt werden, die aktuellen Daten verloren gehen, soweit diese nicht 
gesichert wurden. 
 
 

8 Externer Kontrollanschluss (Serie 300 & 500) 
 
Die Pins für den externen Ausgangsanschluss sind von 1-6 nummeriert. Pin 1 ist jener, welcher sich am 
nähersten zum Anschluss des Netzadapters befindet.  
Die Pinbelegung lautet wie folgt: 

(1) 12 V DC 
(2) Analoger Ausgang 0-5 V 
(3) Steuerung 
(4) High-Alarm 
(5) Low-Alarm 
(6) Masse 

 
Der RJ12-Anschluss erlaubt zwei Arten der Verkabelung, entweder einen Schalter zu Masse, oder ein 12 
V-Ausgang. Wenn der 12 V-Ausgang genutzt wird, erfolgt die Versorgung der Relaisspule durch den 
geräteinternen AC/DC-Richter. In diesem Fall ist darauf zu achten, dass das Relais nicht mehr als 150 
mA zieht und eine Schutzdiode parallel zur Spule geschaltet ist. Wird der Schalter zu Masse benutzt, darf 
zusätzlich die Spannung 24 V nicht überschritten werden. 
 

8.1.1 Alarmanschluss 

 
Hinweis: Diese Funktion kann nur benutzt werden wenn das Gerät mit dem Netzadapter betrieben wird. 
Die Pins für High- oder Low-Alarm können verwendet werden um einfache Ein-/Ausschalter zu 
versorgen, welche wiederum Geräte steuern die lediglich ein Ein-/Ausschaltsignal benötigen, z.B. 
Sirenen. Um zu Masse zu schalten, benutzen Sie die Pins (4), (5) und (6). Für den 12 V-Ausgang 
benötigen Sie die Pins (4), (5) und (1). Die Werkseinstellung basiert auf dem Sensorkopf welcher bei 
Gerätekauf ausgesucht wurde. 
 
Alarm bei hoher Gaskonzentration 

 

 

Warnung: Das Weglassen der erwähnten Diode kann einen Defekt des Gerätes zur Folge 
haben, wenn durch das Relais eine Spannungsspitze erzeugt wird.  
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8.1.2 Steuerungsanschluss 

 
Hinweis: Diese Funktion kann nur benutzt werden wenn das Gerät mit dem Netzadapter betrieben wird. 
 
Der Pin der Steuerung (3) kann verwendet werden um, mittels Steuerung, eine Gaskonzentration 
zwischen oberer und unterer Grenze zu halten. Die obere und untere Grenze kann vom Benutzer 
festgelegt werden. Die Werkseinstellung basiert auf dem Sensorkopf welcher bei Gerätekauf ausgesucht 
wurde. 
 
Um auf Masse zu schalten benutzen Sie die Pins (3) und (6). Für einen 12 V-Ausgang, schalten Sie die 
Pins (3) und (1). Steuerung wird durch Verwendung der Software erreicht. Wird dem Messgerät die 
Versorgungsspannung entzogen, öffnet sich der Schalter, wodurch das gesteuerte Gerät abgeschaltet 
wird (soweit einem „Schließer-Prinzip“ gefolgt wird).  
 
Steuerung der Gaskonzentration 
 

 
 

Warnung: Das Weglassen der erwähnten Diode kann einen Defekt des Gerätes zur Folge 
haben, wenn durch das Relais eine Spannungsspitze erzeugt wird.  
 

8.1.3 Anschluss des 0 ... 5 V-Analogausgangs (zwischen Pin (2) und Pin (6)) 

 
Das Ausgangssignal ist ein Signal welches in der Höhe proportional der Gaskonzentration entspricht. Die 
Spannungsaufteilung entspricht dem jeweiligen Messbereich des spezifischen Gases, z.B. entspricht 
beim Ozonsensor für niedrige Konzentrationen eine Spannung von 0 V einer Konzentration von 0 ppm, 
eine Spannung von 5 Volt einer Konzentration von 0,5 ppm Ozon. 
 
 

9 Sensorkopf Kalibrierung 
 
Die Nullkalibrierung legt den Nullpunkt für die Messung fest. Die Kalibrierung muss unter strengen 
Bedingungen erfolgen, wie da wären:  

 Mindestens 24 Stunden Warmlaufphase 

 Saubere Luft  (Aktivkohle-gefilterte Luft ist am besten geeignet), keine querempfindlichen Gase  

 Stabiler und geringer Luftzug um das Gerät 

 Keine Vibration oder Bewegung des Messgeräts 

 Temperatur 20 °C ± 2 °C 

 Relative Luftfeuchtigkeit 50 % ± 5 % 
 
Eine fehlerhafte Nullkalibrierung führt nicht zu einem dauerhaften Schaden am Gerät. Die Kalibrierung 
sollte allerdings unter o.g. Bedingungen wiederholt werden. 
 

Warnung: Die Nullkalibrierung von Kohlendioxidsonden muss zwingend in einer qualifizierten, 
umgebungsluftfreien Atmosphäre erfolgen. Im Zweifelsfall kontaktieren Sie uns bitte. 
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10 Problemlösung 

10.1 Fehlersuche 

 

Fehlerbeschreibung Mögliche Ursachen Lösung 

Keine Energie - Fehler am Netzteil 

 

- Batterie leer 

- Gerät beschädigt 

- Sensorkopf beschädigt 

- Überprüfen Sie die Leitungen 

/Tauschen Sie das Netzgerät 

- Laden/Wechseln Sie die Batterie 

- Tauschen Sie das Messgerät 

- Tauschen Sie den Sensorkopf 

Sensorfehler bei neuem Sensor - Unzureichende Aufwärmphase 

 

- Unreine Umgebungsluft 

 

- Sensor beschädigt 

- Lassen Sie den Sensor für 24-

48 Stunden auf voller Kraft laufen 

- Bringen Sie das Gerät in eine 

andere Umgebung 

- Tauschen Sie den Sensorkopf 

Hohes Messergebnis trotz 

(relativ) gasfreiem Raum 

- Umgebungsluft 

außergewöhnlich belastet / 

Nullpunktfehler 

 

- Sensor beschädigt 

- Bringen Sie das Gerät in die 

vorgegebene Umgebung und 

führen Sie eine Nulljustierung 

durch 

- Tauschen Sie den Sensorkopf 

Messergebnis in gashaltiger 

Umgebung höher als erwartet 

- Ergebnis korrekt 

Sensoreinsatz kontaminiert 

 

- Sensorlüfter defekt 

- Querempfindliches Gas 

vorhanden 

 

 

- Gas reaktiv und bildet 

Verbindung vor Erfassung 

- Gasfluss zu hoch 

(Ozonmessung) oder zu gering 

(Ammoniak- und VOC-

Messung) 

- Sensor hat Kalibrierung 

verloren 

- Gasgenerator defekt 

Netz und Filter des Sensors 

reinigen 

- Tauschen Sie den Sensorkopf 

- Bringen Sie das Gerät in eine 

andere Umgebung und 

überprüfen Sie es mittels einer 

bekannten Gaskonzentration 

- Bringen Sie den Sensor näher 

an die Gasquelle 

- Sorgen Sie für angemessenen 

Fluss in und um den Sensor 

 

 

- Überholen/Tauschen Sie den 

Sensorkopf 

Messergebnis in gashaltiger 

Umgebung niedriger als 

erwartet 

- Ergebnis korrekt 

- Querempfindliches Gas 

vorhanden 

 

 

- Sensorlüfter defekt 

- Sensor hat Kalibrierung 

verloren 

- Gasgenerator defekt 

- Bringen Sie das Gerät in eine 

andere Umgebung und 

überprüfen Sie es mittels einer 

bekannten Gaskonzentration 

- Tauschen Sie den Sensorkopf 

- Überholen/Tauschen Sie den 

Sensorkopf 
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Messergebnis instabil - Spannungsversorgung instabil 

- Nennstrom falsch 

 

- Luftzug zu groß 

- Umgebungsbedingungen 

ändern sich schnell 

- Rauschen über das 

Datenkabel zwischen 

Messgerät und PC 

aufgenommen (Serie 500) 

 

- Sorgen Sie für stabile Spannung 

- Sorgen Sie für korrekte 

Stromversorgung 

- Reduzieren Sie den Luftstrom 

- Reduzieren Sie die 

Umgebungseinflüsse 

- Stecken Sie das Kabel aus um 

zu sehen ob dies die Messung 

stabilisiert. In diesem Fall 

verwenden Sie ein anderes Kabel 

oder schirmen Sie den PC ab. 

Externer Alarm und Steuerung 

funktionieren nicht korrekt 

- Falsche RJ12-Pins verwendet 

Keine Diode parallel zur 

externen Relaisspule  

- Polarität der Diode falsch 

- Überprüfen Sie die Verkabelung 

Setzen Sie eine Diode ein 

 

- Korrigieren Sie die Polarität 

Datenverbindung instabil (Serie 

500) 

- Leitung unterbrochen 

 

- Einstellung des COM-Ports 

falsch 

- Uhreinstellung falsch 

- Prüfen Sie das Kabel und die 

Anschlüsse 

- Nehmen Sie die korrekten 

Einstellungen vor 

- Synchronisieren Sie die Uhr des 

Messgerätes mit der Uhr des PC 

(mittels der Software). Wenn dies 

nicht möglich ist, kann die 

geräteinterne Batterie defekt sein. 

Wenden Sie sich an PCE. 

 

10.2 Sensorausfall 

 
Die Geräte verfügen über integrierte Diagnosefunktionen um Sensordefekte zu erkennen. Falls ein 
Sensorkopf ausfällt, kann er durch wenige Handgriffe ausgetauscht werden. Ein ausgefallener Sensor 
kann zu PCE zurückgesandt werden, um aufbereitet oder entsorgt zu werden. 
 

Fehler-
beschreibung 

Display-
anzeige 

0-5 Volt-
Ausgang 

(S300 / 500) 

Steuer-
ausgang 

(S300 /500) 

Low-Alarm-
Ausgang 

(S300 /500) 

High-Alarm-
Ausgang 

(S300 /500) 

Daten-
logging 
(S500) 

Kein Fehler 
Gültiger 

Messwert 

Wert 
proportional 

zum 
Messergebnis 

Wie vom 
Benutzer 
eingestellt 

Wie vom 
Benutzer 
eingestellt 

Wie vom 
Benutzer 
eingestellt 

Gültiger 
Messwert 

Sensor 
defekt 

„Sensor 
failure“ 

5 V Offen Geschlossen Geschlossen 9999 

Sensor 
überaltert 

Gültiger 
Messwert 
+ „Sensor 

aging“ 

Wert 
proportional 

zum 
Messergebnis 

Wie vom 
Benutzer 
eingestellt 

Wie vom 
Benutzer 
eingestellt 

Wie vom 
Benutzer 
eingestellt 

Gültiger 
Messwert 

Verbindungs-
fehler 

Gerät 
schaltet 
sich ab 

0 V Offen Offen Offen 
Keine 

Ausgabe 

Sensor 
Standby 

Standby-
Symbol 

0 V Offen Offen Offen 
Keine 

Ausgabe 
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11 Richtlinien zur Ozonmessung 
 
Die folgenden Informationen zeigen ihnen, wie Sie eine Ozonmessung am effizientesten durchführen. 
 

Allgemein 
 

- Ozon ist schwerer als Luft und sinkt nach unten. Demnach sollte die Ermittlung von Leckagen an 
Ozon generierenden Geräten an der am besten dafür geeigneten Stellen durchgeführt werden. 

- Ozon reagiert und zerfällt auf Oberflächen wie Wänden, Möbeln usw. 
- Da der Geruch von Ozon sehr stark von den Lokalen Umgebungsbedingungen beeinflusst wird 

und das Geruchsempfinden von Mensch zu Mensch anders ist, ist dieser kein zuverlässiger 
Indikator für das Vorhandensein oder die Konzentration von Ozon. 

 

Permanente Geräte Platzierung 
 

- Die Aq Ozonmessgeräte wurden entwickelt um die Ozonkonzentration der Umgebungsluft zu 
messen. Die Messgeräte dürfen nicht direkt im Ozonstrom platziert werden. 

- Für die Innenraumüberwachung müssen Sie das Gerät auf einer inerten Oberfläche befestigen 
und darauf achten dass der Sensoreinlass nicht blockiert wird. 

- Bei der Leck Suche muss das Gerät in der Nähe des Verursachers platziert werden. 
- Achten Sie darauf dass das Gerät vor äußeren Einflüssen wie z.B. Spritzwasser, Staub, 

Erschütterungen, extreme Hitze, extreme Kälte, hohe Ozon Konzentrationen und hohe 
Luftfeuchtigkeit geschützt ist. 

 

Fehlerhafte Messergebnisse 
 

- Die Aq Ozonmessgeräte wurden entwickelt um ausschließlich auf Ozon zu reagieren. Dennoch 
können die Messergebnisse durch andere Oxidierende Gase wie z.B.  Chlor oder Stickstoffdioxid 
verfälscht werden, wenn diese in zu hoher Konzentration vorliegen. 

- Hohe Konzentrationen von kohlenwasserstoffgasen, wie z.B. Dämpfe von Alkohol, Öl und 
Lösungsmitteln können die Ozonkonzentration verringern oder verschleiern. 

 
 

12 Entsorgung 
 

Batterien dürfen aufgrund der enthaltenen Schadstoffe nicht in den Hausmüll entsorgt werden. Sie 
müssen an dafür eingerichtete Rücknahmestellen zu Entsorgung weitergegeben werden. 
 
Zur Umsetzung der ElektroG (Rücknahme und Entsorgung von Elektro- und Elektronikaltgeräten) 
nehmen wir unsere Geräte zurück. Sie werden entweder bei uns wiederverwertet oder über ein 
Recyclingunternehmen nach gesetzlicher Vorgabe entsorgt. 
 
 
Bei Fragen kontaktieren Sie bitte die PCE Deutschland GmbH. 
 
 
 
 
 
 
 
 
 

Eine Übersicht unserer Messtechnik finden Sie hier: http://www.warensortiment.de/messtechnik.htm 

Eine Übersicht unserer Messgeräte finden Sie hier: http://www.warensortiment.de/messtechnik/messgeraete.htm 

Eine Übersicht unserer Waagen finden Sie hier: http://www.warensortiment.de/messtechnik/messgeraete/waagen.htm 
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